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Social networking includes such programs as
FaceBook and Twitter.
Jane Quinn will give a presentation on the
social networking going on in every phase of the
Internet now and invite audience participation of how
members are using their social Internet interaction.

Door Prizes
1.

DVD Player

CUGR
Calendar
CUGR Board Meeting
3:15 PM Monday, May 30

2. PC Flexible
Web Cam

at Redding Library in the
Foundation Reading Room

MULTI-MEDIA
10 AM, Saturday, May 21

3. USB
Extension
Stand
One free ticket to each
member at the door!

6 PM Club Business
& Presentation
Sign in at the Greeting Table and pick up
your name tag and please leave it in the
Tag Box when the meeting is over. Also
please stay and help reset the tables to
the Library’s original arrangement.
Thank you.

Future Meeting Change!
Due to Library room demands, we will
meet on Monday, June 27 at 6 p.m.

WINDOWS & MORE
No Meetings Until
Further Notice

DTP SIG
No Meetings Until
Further Notice
See back page
for more SIG information

GENERAL MEETINGS ARE
at the Redding Library
100 Parkview Ave,
off Cypress.

OFFICIAL WEBSITE IS
http://cugr.apcug.org/
For more information
call any Board member
listed on Page 2.
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Motherboard Newsletter Policies and Deadlines
The Motherboard newsletter is published
monthly by the Computer Users Group of
Redding, PO Box 494778, Redding, CA
96049-4778. The CUG is a 501(c)(3) nonprofit corporation. Subscriptions are
included in the $25 annual membership
fee. The purpose of the newsletter is to
inform members of upcoming events and
provide information about the use of IBM
compatible computers.
Disclaimer: Neither the CUG, its Officers, the Editor, nor the newsletter
contributors assume any liability for
damages incurred due to the use of
information provided in this publication.
Reprints: Articles from this newsletter
may be reprinted by other user groups if
credit is given to both the author, CUG
and the Motherboard. Mail a copy of the
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newsletter where the article is reprinted to
the Editor at the address in the first
paragraph of this text.
Personal Ads For Members:
Requirements are:
1. Advertiser must be a member.
2. The item must be computer-related.
3. The ad must be received by editor J. Ball
by the monthly date of the board meeting.
Sorry, no exceptions.
Other terms must be approved by the club’s
Board of Officers and Directors.
Article Submissions: All articles and
reviews must be submitted to J. Ball by the
Monday of the monthly Board meeting
(see Page 1 for date.) Sorry, no exceptions.
Motherboard Editor reserves the right to
make corrections and deletions in all articles
in the interest of grammar, style, and space.
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Cloud Computing
by Dick Maybach, n2nd@charter.net
Although you can hardly pick up a
computer publication without being
assaulted by references to c loud
computing, the term has been abducted
by marketing organizations to the extent
that it means almost nothing. Today,
“cloud” is to computing as “natural” is to
food. Although the term means little, the
concept is very valuable, and is something that most computer owners use
every day. I define cloud computing as
using storage or processing resources on
the Internet. Most of us already use cloud
computing far more than we realize; for
example, every e-mail we receive sits on
our ISP’s disk until we download it to our
PCs, and when we use Google Maps,
much of the processing and all of the
storage occurs on Google’s hardware. In
the extreme, cloud computing could
evolve to the point where our computer
would consist of only a keyboard, mouse,
display, and perhaps a printer, with just
enough processing power and software
to support a Web browser. Google
foresaw this as the future of home
computing and began developing their
Chrome operating system to support it.
A simple example of cloud computing
is a backup service, which continually
backs up all your data whenever you are
connected to the Internet.You don’t have
to think about it, and because your
backups are stored at a different location,
they are safe even in case of a local
catastrophe. A similar use is synchronizing data among several computers,
where the data might be files, contacts,
and your favorite Web sites and (with
care) their passwords. Many people also
use the cloud to share information with
others, for example by using Facebook
for personal information, Flicker for
photos, or Google Docs for documents.
Cloud storage is both convenient and
inexpensive; indeed, many vendors offer
up to two gigabytes free.
All the above examples are data
storage ones, but there are also cloud
processing services, such as Google
Docs. Google Docs supports the
common office tasks such as word

Continued on Page 6
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April Meeting

Congratulations To Our Winners!

Anna Lee Horton
won the
External
Hard Drive

Dave Cox
won the
the Reading
Lamp and Canon
Photo Paper

Jerry Hurley
won the
Cable Organizer
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An Evening With Crown Camera!
Come Celebrate Luci with Crown!
Spring Cleaning
Poem
I asked the Lord to tell me
why my house is such a mess.
He asked if I’d been
‘computering,’
and I had to answer ‘yes.’
He told me to get off
my backside,
and tidy up the house.
So I started cleaning up...
the smudges off my mouse.
I wiped and shined the
topside, and
that really did the trick...
I was just admiring
my good work and
I didn’t mean to ‘click.’
But click I did, and oops!
I found a real absorbing site,
that I got SO way into it...
I was into it all night.
Nothing’s changed
except my mouse.
It’s very, very shiny...
I guess my house will stay a mess...
while I sit here on my hiney.

CUGR
MEMBER WEBSITES
MEXICAN-TOURS
www.mexican-tours.com
Lyle VanNorman
bbcreelmx@yahoo.com

Publicize Your WebSite
Here for FREE!
(Members Only Please)
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Thursday May 26th, 6:30PM
At this FREE EVENT, you’ll learn how to
create, print, download and upload your
digital images with ease!
That’s not all!
We’re even going to show you what to do
with your pix that are stuck on your
home computer & what to do with your
images on Facebook!
Crown Camera Since 1957
1365 Market St.. Redding Ca.
530-243-8333
Visit Us!
www.crowncamera.com

Welcome Renewals

Mike Doyle
Dave Cox
Micheal Mudzan
Mary Montague
Larry Owings
THE MOTHERBOARD

Creativity
Starts
With
Crown!

Membership
Cost Break
FROM THE BOARD
The board will give a 1/2
off membership dues
break for every new member a member brings to
the club. And the new
membership will recieve
a two-month break from
their $25 dues.
This began in January
2011. Just make certain
to inform a board member at the entry table if
you have a new membership sign up.
May 2011

Check Out APCUG

Bits And Pieces

by Eugene Freeman
Here’s an idea on how to let your group
OR — Find Florida in the list of states
know a little bit about APCUG. It’s from
and click on Central Florida Computer Sothe Henry Ford Village Computer Club,
ciety. http://www.cfcs.org/newsletter.asp
Dearborn, Michigan, newsletter (October
OR — Find the MOTHERBOARD, a
— December 2006 issue) — Eugene
publication of the Computer Users Group
Freeman, editor. It features one aspect
of Redding, CA. Of course look in the Caliof apcug.net — the online newsletter list.
fornia list of clubs. http://users.snow
WHAT IS APCUG?
crest.net/ibmpcugr
It’s the “Association of Personal
Ohio is near — check out http://www.
Computer User Groups.”
acpcug.org/site3/presentations.htm
Do you know that our Club is a
(Akron Canton PC Users Group) and click
member of APCUG?
on Past Newsletters.
IF Yes! Then have you explored the
Look at all the sites you can contact
many other clubs located in the USA,
from their Web site. There are over 300
Canada, Japan, and Australia that are
Computer Clubs that belong to APCUG.
also members? If not, you are missing
WHY BOTHER?
something.
Because the Computer Club newsIF No! And you are interested in findletters — current and past — keep you
ing out — click on http://www.apcug.net
informed on what they are doing. And get
Oh! Too much to click on, of course.
helpful tips and tricks that other Club
Start with Newsletters, then Online
members have found and are sharing. If
newsletters.
you find a good one to share, send it to
’STATES’ PICK THE STATE YOU WANT
your Editor.
What state should I pick first?
Try Canada, our neighbor. Big Blue &
How about Michigan. The Henry Ford
Cousins: http://bbs.bbc.org/newsletter/
Village Computer Club AND the Southindex.php
Eastern Michigan Computer OrganizaThen tell us what you find of interest
tion, Inc. http://www.semco.org/ are
that you think our Club should consider
members of APCUG.
doing.

by Rush Blodget; IMB/PCUG of
Redding, rmaxtwo@charter.net

Humor For May

~~~~~~~~~~~~~~~~~~~~~
If Companies Merged, They Would Be 3M + J.C. Penney + Metropolitan Opera Company:
“Three Penney Opera”
Grey Poupon + Dockers Pants: “Poupon Pants”
May 2011
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CHARTER COMMUNICATIONS
ACCESS
DIFIICULTY

Last month my
normally excellent
broadband signal
from Charter became quite weak
and “broke off’ a
num ber of times. On calling Charter their
technician asked what make and model
modem I was using and its number. After
giving them this information they told me
that they had made changes in their equipment that made my modem no longer
compatible. They sent a representative
out to replace it without charge. This still
left some problems for which it was necessary to call the manufacturer of the router
who had me reconfigure it. At this point
the signal again became five bars strong.

GOOGLE BOOKS
I suspect that many of you are already
familiar with Google Books. I was not
aware that their announced project of
scanning the world’s libraries seems to
have been completed and was amazed
at what they have done. The total content
of any book on which the copynght has
expired or that never was copyrighted
can be downloaded free. To facilitate this
they have copied to their data base all
the world’s libraries book indexes. Google
comments that a person may presume
that a book published in the United States
before 1926 will no longer be protected
by the copyright law. Books published in
other countries may have different criteria
for final extinguishment of a copyright.
A comment also made was that some
books published and copyrighted a hundred years or so ago may have been recopyrighted by the making of some minor
change, but not to worry, just download
the previous edition on which the copyright has expired. A fee that is still in the
process of being negotiated will be charged for those books still under copyright.
To my surprise I was able to easily find
and download a limited edition book published 160 years ago in England. Books
can also be downloaded in Adobe PDF.
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Multi-Media SIG UpDate

by SIG Leader Jane Quinn, qjquinn7427@gmail.com
Weekly SIG Group meetings are every Thursday at the Anderson
Senior Center from 1- 3 pm. For special projects or one on one assistance
walk-in 3 - 4 pm. You can also connect to the classroom at high speed
internet through SKYPE that id is AAASCO2009.
Our monthly Multi-Media SIG is the Saturday, May 21, before the club’s general
meeting at our home from 10 am to noon. For directions contact me via e-mail
above or phone, 365-0825.
Satellite E205 and the Sony VAIO Series
This week I was reminded once again
laptops have this technology. There is a
how often our members share their
quick-launch key next to the keyboard
knowledge and new discoveries. After all,
that instantly brings up the WiDi software.
there are hundreds of resources for techHit the connect button, and the desktop
nology solutions through the internet,
environment is ported over to your HDTV,
newsletters, and magazines. We couldn’t
wirelessly. Awesome! So before you run
possibly subscribe to them all, nor read
off to buy that next laptop check out the
everything of notable interests for our
latest technology features.”
computer hobby.
The second piece of information came
The first to share was Marlene Robinfrom Anna Horton who found a new free
son who told the group of a new type of
version of Real Player that captures
laptop with WiDi technology which
videos from many video file types
wirelessly recognizes a television.
including Utube. If you use Picasa Web
Wireless Display is not new , however,
albums they won’t download video files,
another flash drive-looking device has to
just photos. However, Realplayer will
stick out from one of your laptop’s USB
down-load those web videos. It’s a “free”
ports to use it. Quote from the Intel’s
product called RealPlayer, from real
website. “Intel’s Wireless Display (WiDi)
.com. It makes short work of downtech-nology can output laptop video
loading videos of all kinds. With
directly to a TV using the notebook’s builtRealPlayer installed, you’ll see a button
in 802.11n chips With Intel’s WiDi, the
labeled “Download This Video” when you
technology is built in to the laptop, so that
point your mouse just above the top
it’s one less thing to carry, but you still
right corner of the video. It also comes
need a receiver: In this case, Netgear is
with a RealPlayer Converter, which can
the only provider of a receiver box solution
strip out the video and save the audio
that will enable WiDi to work with your
in MP3 format. I should also point out
laptop. Its application is straightforward:
that YouTube downloaders and converYou hook up the Netgear Push2TV
ters are among the most popular
PVT1000 to an HDTV via HDMI or RCA
programs on Download.com.
(Red, Yellow, White) jacks in the back of
See you at the next Sig Saturday May
the receiver. The laptop would then have
21, 10am to noon, or at the Thursay Sig.
to pair with the receiver by launching
Editor’s Note: RealPlayer will also conIntel’s WiDi software, which is already prevert .wmv and .mp4, plus other formats.
installed in your laptop. Both the Toshiba

CLOUD COMPUTING
Continued from Page 2
processing, spreadsheets, and presentations, which means you can perform
these without purchasing an office suite
and having to keep it updated. It also allows
on-line collaboration (where, for example,
several people edit the same document),
although few home users are likely to
need this feature. Like cloud storage, cloud
processing is inexpensive or even free.
By now, you may be thinking, “What’s
the Catch?” Somebody has to pay for
these services, as providing them requires
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non-trivial costs for computer hardware,
support staff, and communications. In
some cases, the free service is a limited
sample to entice you to purchase a more
versatile one. In others, you are the product
being sold. Your habits and preferences
are valuable commodities that advertisers will pay to learn about. For many of
us this is a fair trade; in return for the convenience of Google’s search engine, we
tolerate the ads in the sidebar and being
directed to sites that want to sell to us.
However, there are some security and
safety caveats involved. Security is com-

THE MOTHERBOARD

plex for a cloud vendor; your data are
stored on the same disks, the same
memory, and pass through the same
processors as everybody else’s. The
process is much like what happens in a
commercial laundry or dry cleaner, where
everybody’s clothes are tagged and
thrown together into a large machine.
Afterwards, somebody looks at the tags
to get them back to their proper owners.
Contrast this to a bank deposit vault, where
only your key can open the box where
you place your documents. Even at such
competent vendors as Google, there have
been instances of data leaking from one
customer to another, and many cloud
vendors are start-ups who have much
less expertise than Google. This means
that you should take responsibility for
safeguarding your data. For example, if
you back up your disk in the cloud, encrypt
any files (such as those containing
passwords or on-line banking data) that
present security risks. I store my
passwords using KeePassX, http://
www.keepassx.org/. Its file is always
encrypted on your PC’s disk, and you can
safely back it up anywhere. I also use Gnu
Privacy Guard (gpg), http://www.gnupg
.org/, to encrypt files and e-mail. (Both of
these programs are available for the
Windows, Mac, and Linux platforms.) By
the way, when you encrypt a file, be sure
that only the encrypted version is ever
placed in a directory that is backed up in
the cloud.
Safety also is not trivial. Vendors do go
out of business and, even if they keep
operating, they may find that providing
cloud services isn’t profitable. Not all of
them back up their storage, which means
that their hardware failures and software
bugs can destroy your data. If you use
the service for back-up or synchronization, this isn’t a problem because the
chances of simultaneous failures in the
cloud and on your PC is negligible.
However, if you store your only copy of
your photograph or music collection in the
cloud, you are risking disaster. In the case
of cloud processing, you should also be
concerned about the format in which your
data is stored. It does little good to
download the file containing your novel if
it’s stored in a format that only the (now
out of business cloud vendor) could read.
Finally, cloud computing is new, so
you should expect some glitches.
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All About CD And DVD Burning
(NAPSA)—If your computer, digital
camera and camcorder are getting
overloaded with digital files—photos,
movies, music and data—now’s the time
to buy software that will let you creatively
“burn” everything onto CDs and DVDs.
You may have heard about this type of
software, but aren’t exactly sure what it
does. Here are answers to some of the
most frequently asked questions:

WHAT DOES “BURNING” A CD OR
DVD MEAN?
“Burning” is just a technical term for
“copying.” Today’s software products let
you burn digital files that are on your
computer, your digital camera and
camcorder — and even VHS tapes —
and make personalized CDs and DVDs
that you can play anywhere.
Why should I burn copies of my digital
files? It’s important to make backup
copies of all your digital files in case anything happens to the originals. Floppy disks
and zip drives are good for copying small
amounts of data, but today’s photo, music
and movie files need more space — which
can only be found on CDs and DVDs.

WHAT DOES THE SOFTWARE DO?
CD- and DVD-burning software, such
as DVD MovieFactory Disc Creator from

Ulead, doesn’t just make copies of your
files — it also lets you add creative
elements before you copy everything onto
a CD or DVD disc. Here’s a look at what
you can use the software for:
• Movies. Is that vacation or wedding
movie a bit too long or boring? Use the
software to trim unwanted scenes, add
in creative titles to highlight a special
moment, add Hollywood-style transition
effects between scenes and insert some
voice-overs and music. Then burn copies
to share with (and impress) your friends
and family.
• Music. With this software, you can
burn your music collections and create
your own “greatest hits” CDs with all types
of audio, including MP3 and WAV.
• Photos and Slideshows. Use the software to store your photos, or make them
come to life in a fast-moving slideshow.
Add motion menus, transitions between
photos, titles and music, before burning to
a DVD disc.
To make things really easy, look for
one of the new versions of software from
companies like Ulead (www.ulead.com)
that let you drag files to the quick-drop
icons on your desktop without having to
fully launch the software.

division multiple access) developed by
our local Qualcomm company. This is
a very complex encoding that allows
many more users on the same channel
at the same time.
G3 is probably the most common
system in use today.
G4 arrived in 2006 and allows 1 Gbt/s
(one gigabit per second) downloads from
a fixed location or 100 mbt/s (megabits
per second) from a moving vehicle.
These high speeds allow streaming highdefinition video (HD movies) on your cell
phone. Also, connections to the Internet
are faster and better. G5 is still in the lab
and promises even more features, but
may not arrive before 2020.
The cell phone field is rampant with
3, 4, and 5 letter acronyms. Here are a
few that a salesman may try to impress
you with:
GMS (global mobile system): still
widely used in older phones.
TDMA (time domain multiple access):
sharing the airwave in small time slots.
FDMA (frequency domain multiple access): sharing the airwave in different
frequencies.
CDMA (see above).

Cell Phone Lingo
by Wil Wakely, President, Seniors Computer Group, CA
March 2011 issue, Bits and Bytes, The Official Electronic Newsletter of the
Seniors Computer Group, www.SCGsd.org, wilw@adnc.com
When it’s time to buy or upgrade to a
new cell phone, are you as confused as
I am with all the fancy terms and
acronyms in the sales pitch? They make
my head spin. Some of the terms you
will encounter refer to the technology
generation of the phone, as in G0 to G5.
About every 10 years the next larger G
(generation) number appears denoting a
major improvement in cell phone
technology. Each generation improves
the speed, security, power usage, range
and reliability of cell phones.
G0 refers to the original mobile
telephone, a large unit stored in the car
trunk with a hand-set between the driver
and passenger seat. Remember those?
Essentially it was a souped-up shortwave radio. These first made the scene
via Motorola and Bell Telephone in the 50’s.
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Next came G1 using GMS tech (see
below) which also was analog, first
introduced in Japan in 1979 and later in
the USA in 1983. In 1992, G2 was a major
improvement using digital technology vs.
analog that was used in G1. So what’s
the difference? Analog is a continuous
smooth signal like whistling a tune. Digital
rapidly samples the song and converts
each small time segment into a series of
ones and zeros, or digits. Through some
clever complex calculations, these digits
are converted back to the original sound
tone and volume. The advantages of digital
are that the data can be compressed and
encoded for security and no information is
lost as long as the 1/0 signal can be detected, even from a lot of accompanying noise.
In 2001, 3G was introduced using a
new technology called CDMA (code
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An analogy to the problem of multiple
access is a room (channel) in which
people wish to talk to each other simultaneously. To avoid confusion, people
could take turns speaking (time division),
speak at different pitches (frequency
division), or speak in different languages
(code division). Other terms you may
encounter are LTE (long term evolution),
OTDMA (orthogonal TDMA) and WiMax
(similar to WiFi). These are fancy names
for some of the latest improvements in
the field. So the best strategy for buying
a new cell phone is to read the reviews
and then find a salesman you can trust.
Some of the above information may
help you understand his pitch and also
impress him with your knowledge.
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When Outlook Dies, Windows Live Mail lives
by Jo Grazide, Leader, Word Processing Workshop, Brookdale CUG, N J, Mar 2011 Issue, Bug Bytes, http://bcug.com, gio520@gmail.com

Above screenshot of Windows Live
Mail showing message window with
attached photo images.
All screenshots: Jo Grazide
I had been using and enjoying the
features of Microsoft Outlook 2007 since
2007, never imagining that one fine day I
would log in only to see a message saying
something to the effect that Outlook was
in use and that I had to close a “pst” file,
or face the consequences. In fact, MS
Outlook simply stopped. I was unable to
move appointments, open an email, or
do anything that I was accustomed to in
order to make my activities on the
computer enjoyable and efficient.
For lack of a better option, I decided to
turn to Windows Live Mail (WLM), a part
of the Windows Live Essentials suite that
was already installed on my system along
with my favorite photo management
program and even my antivirus app.
Since this was already present, I didn’t
have to do much, except launch it. It
happily grabbed my mail downloads from
Gmail and politely asked me if I wanted it
to be the default email program. I said “Yes!”
I was pleasantly surprised. I use Gmail
but I was pleasantly surprised. I use
Gmail but only for the convenience of
having an online calendar and email
program that I could access from any
computer. As far as WLM, I would say
the only real inconvenience is the loss
of my Outlook calendar, but I can
manage using the online Google
calendar whenever I’m on my desktop.

FIRST IMPRESSIONS
When you first use WLM, you are
obligated to establish a connection with
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your ISP (Internet Service Provider). Since
I use Gmail/Verizon/Hotmail/Yahoo, I can
add these by going to the accounts Tab,
clicking on the Email icon and adding an
account. Since I sync everything on
Gmail’s server, there is no need to do this.
In fact, it gets kind of confusing when
lots of email accounts are listed, at least
for me. So I stick to my Gmail account
and things have been going smoothly.

TABS AND RIBBONS
Cosmetically, the interface is clean,
uncluttered and easy to understand.You
start with a Quick Access Toolbar and
tabbed ribbons familiar to those of us
using current MS Office apps. The tabs
are: Home/Folders/View and Accounts.
Let’s take a peek at each.

Screenshot Of Home Ribbon
The Home tab is where you compose,
create Photo emails, mark as junk, and
for those Calendar challenged like me,
an opportunity to add a message to that
calendar. This may be the workaround I
need. Anything to save typing! You will
see a sign in request on the right side.
You don’t have to be a member of
Hotmail or Windows Live or sign in. I do
so under my Hotmail name, as this allows
the computer to sync and recognize my
name on many other sites, such as
Facebook, Windows Live Mesh, and
others too tedious to mention here. I am
a social networker, and am comfortable
with such arrangements, but you don’t
have to subscribe to these. The email
program will still work for you, happily. I
really like the Photo email option. In the
example shown above, notice how the
pictures I chose are inserted as an
album, and also that a picture tools and
a photo album tools ribbon is provided.
Even though that may be considered
overkill on Microsoft’s part, it is still
handy in case you want to do a bit more
work before sending your pictures out.
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Screenshot Of View Ribbon
Also useful is the View ribbon. Here
you can change the layout of your
screen. My favorite button here is the
Account color — among others, you can
change your theme to Fuchsia or
Smoke. Other colors you can use are
Lime or Twilight. Someone must have
had a sense of humor when they wrote
this app. But you can use a different
color for multiple accounts, so there is
a reason for this virtual rainbow.
The Accounts ribbon is one I hardly
go to.

Screenshot Of Accounts Ribbon
Anything here is handled elsewhere.
In fact, IMAP folders or Newsgroup is a
bit beyond what I need in my email
program, so I leave these alone.

SUMMING UP
In using WLM, there is little to worry
about. It will download your messages,
keep your appointments once you enter
them, and handle your contacts. In fact,
it handles contacts only too well. I was
happy to see that it has the uncanny
ability to find and list my Facebook
contacts as well as the ones imported
from MS Outlook. It won’t list their
emails or any unavailable information,
but it does three things I like. It gives
me a picture of the friend from their
Facebook profile, a link to their online
Facebook page, and whether they are
currently there. So even if I’m not online,
I can quickly get to their page and see
what my fellow networkers are up to.
LinkedIn also seems to be important
enough to be included in this feature.

NO CALENDAR SYNC
A quick mention of the Calendar –
since it does not sync with Google
calendar, unless I have a lot of time to
re-enter my appointments, Google will
have to be my source of information. I

Continued on Page 9
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PC Cooling - Keep it Cool!
by Phil Sorrentino, President, Sarasota Personal Computer Users Group, Inc., FL,
February 2011 issue, Sarasota PC Monitor , www.spcug.org, president @spcug.org
sure you unplug the
Just like your car, your computer has
ambient air (the lesser hot area). The heat
computer before you do
to be cooled because it generates a lot
sink helps cool the CPU by transferring
this. While you are in
of heat. Some of the computer’s componheat from the CPU, at a relatively high
there checking, take a
ents produce large amounts of heat during
temperature, to the ambient air, at a
can of “dust remover”,
operation, and this heat must be removed
relatively lower temperature. This transfer
which is like compressed air, and blow
in order to keep these components within
of heat keeps the CPU from overheating
out all of the dust you can see, especially
their safe operating temperatures. PC
and possibly shutting down. The most
around the CPU heat-sink. Also, make
Cooling, then, is the process of removing
common design for a heat-sink is a piece
sure all of the inlets and exhaust holes in
the heat from the computer’s components.
of metal with many fins. The large surface
the case are free from dust and debris so
Components which produce heat and are
area due to the fins results in the rapid
that the normal air flow will not be
susceptible to performance loss and/or
transfer of heat to the surrounding, cooler
disturbed. That can of “dust remover” is
damage due to that heat include integrated
air. A fan improves the transfer of heat
your best defense against dust buildup
circuits, such as the Central Processing
from the heat-sink to the air by moving
both on the heat-sink surfaces, and
Unit (CPU), graphics processors, chipcooler air between the fins. This is how
around the air holes. (Keep a can of dust
sets, and memory. Hard drives also prothe combined heat-sink and fan work to
remover close at hand and give a
duce heat but typical air flow is usually
cool down the CPU chip.
package of them to your computer owning
adequate to keep them within their
friends during the holiday season.) Follow
operating temperature. (Although some
the directions on the can. Be especially
of the very fast drives (10,000 rpm), may
careful not to hold the can on an angle or
need additional cooling.)
upside down, as doing so may force out
Most of the heat produced in a coma flammable freezing liquid. (Note that it
puter is generated by the power supply,
is normal to feel the bottom of the can
the CPU and possibly the graphics
getting cold while the can is blowing air.)
processor. That’s probably where you’ll
If you blow out the dust every 3 to 6
find the additional fans (beyond the
Now all that may seem a bit acamonths, your computer should run nice
normal chassis cooling fans). You might
demic, but the point is that the comand cool for many years, and you’ll be
not think such a small electronic chip,
ponents inside the PC must be cooled.
spared some very strange and possibly
the CPU, could generate so much heat,
You know how good you feel when you
aggravating problems.
but many modern CPUs need a separate
turn on a fan on a hot day. The heat© 2010 by Phil Sorrentino
fan mounted on a heat-sink to remove all
sinks and the fans are necessary for
of the heat generated. Overheated parts
your computer to continue operating.
generally exhibit a shorter maximum lifeSo, if your fans stop or your heat-sinks
WHEN OUTLOOK DIES
span and may give sporadic problems
stop being effective, your computer will
Continued from Page 8
resulting in system freezes or crashes.
eventually stop operating. If a fan stops
PC Cooling is mainly done using heat
it is usually easily noticed either by
have read recently that Yahoo Mail will
sinks to increase the surface area which
seeing it stopped when the computer
sync with WLM and Google, but have
dissipates heat, fans to speed up the
is on or the lack of air flowing or the
not had the time to really investigate
exchange of air heated by the computer
lack of the sound of the fan motor. It’s
this. With the way that the Internet is
parts for cooler ambient air, and in some
the heat-sinks operation that is hard
combining profiles and individuals’
cases soft cooling, or the throttling of the
to determine. The best way to discern
information, it would just be one more
speed of some computer parts in order
the operation of the heat-sink is to look
intertwining of online information. Perto decrease heat generation.
at it. (Yes, that means removing the
haps in time there will be a better way
First a little thermodynamics review. A
cover.) It should be nice and shiny and
to do this.
heat-sink is an object that moves heat
new looking, and not covered with dust
I will miss MS Outlook. But I will not
from an object that it is trying to cool, to
or animal hair. Dust covering the heatmiss the fact that one fine day it just
a lesser hot area or object. It absorbs
sink will impede its ability to transfer
stopped working, gave me strange error
heat from an object, and transfers that
heat to the air, even if the fan is moving
messages, and was unwilling to be
heat to another object or the surrounding
the air over the dust laden heat-sink.
reinstalled properly. I know that there
air. In the computer, a heat-sink, usually
A visual check of the cleanliness of the
are always more options, and WLM is
made of aluminum, is placed in direct
heat-sinks every three to six months is
a fine option. Being downloaded from
contact with the CPU chip. A thermal
advisable. (Maybe even more often if your
the Internet, it is always up to date and
grease is used to help the heat transfer
computer is in a dusty environment, {like
free. Try it if you want to use a local
from the CPU chip to the heat-sink. The
in the corner of a room on a rug}, and/or
email program with lots of features and
heat is then typically transferred to the
you have furry pets in the area.) Make
an uncomplicated interface.
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Add Text On A Photo in Word 2007
by Lynn Page, Editor, Crystal River Users Group, FL, Dec. 2010 issue, CRUG newsletter, www.crug.com, newsletter@crug.com
the photo, but you can’t rotate it. To be
When creating a document it may be useful to place text with or on top of a
able to rotate the text or use text that is
photo. You could create a new photo with the text in a digital photo editing application
more stylized use WordArt.
and then save it for use. But if you will just use that image once, why go to the
WORDART ON TOP OF A PHOTO
bother? Within Word 2007 you can add the text on top of your photo using either
To place WordArt on the photo first
WordArt or a text box.
create
a Drawing Canvas. Place the
Which method to use depends on the effect desired. For text that is short and an
insertion
point in the document and then
interesting stylized look is what you want WordArt is a good option. For plain and
in
the
Illustrations
group on the Insert
simple text a text box can match the text to that in the rest of the document.
tab
open
the
Shapes
drop down menu
Text Box on Top of a Photo
and
click
New
Drawing
Canvas.
Placing a text box on a photo can be as easy as inserting the photo, creating a
With
the
new
drawing
canvas still
text box and dragging the text box onto the photo.
selected on the Inser t tab, in the
Illustrations group, click Picture. In the
dialog box browse to and select the
photo to use and click the Insert button.
Again on the Insert tab, but in the Text
group, click WordArt, select the style
desired, and type the text. Select either
piece of art and use the sizing handles
to resize as desired. Click the outside
edge of the WordArt to select it and
drag it over the photo. Use the rotation
To add a photo to a document place the insertion point in the document where
handle to rotate the text to the angle
the photo is to be located and click the Picture icon in the Illustrations group on
that works best for the photo.
the Insert tab. Browse to the photo in the Insert Picture dialog box, select it and
Once the graphics are correctly
click the Insert button.
formatted
and positioned group them.That
To place a text box on the photo first create the text box. Place the insertion
creates
a
single graphic that can be
point on a line below the photo. Then in the Text group on the Insert tab, click text
moved
or
resized.
The text stays with the
box and then click to select Simple Text Box. In the inserted Text Box type the
photo.
To
create
a
group
click the outside
text. To change the font or style of the text, highlight the text and then select the
edge
of
the
photo,
press
and hold the
desired text formatting as with any other text. Drag the text box sizing handles to
CTRL
key,
and
click
the
edge of the
resize it as necessary. Finally click the outside edge of the text box and drag it to
WordArt
so
both
items
are
selected.
the proper location on top of the photo.
Under Drawing Tools, on the Format tab,
in the Arrange group, click the arrow next
to Group, and then click Group.

The default Text Box will
have white fill and a black
border. For use over a photo
you will probably want no fill
color or border. With the Text
Box still selected click Text Box
Tools and on the Format tab,
in the Text Box Styles group,
click Shape Fill and select No
Fill. Then click Shape Outline
and select No Outline.
With the Text Box you can
add text on top of a photo and
move the text to position it over
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Crown Camera
Imaging Experts
Digital Cameras

M-F 8:30 - 5:30
Photo & Printer Supplies
Sat. 9 - 5
www.crowncamerashop.com
530-243-8333 or 800-655-4256
FAX: 530-243-4978

1365 Market Street
Redding, CA 96001

Greg Rogers & Gale Vaughn, Owners
530-275-4455
4432 Shasta Dam Blvd.

4161 Front Street
Shasta Lake City
(530) 275-1900

“Northern California’s Finest and First Internet Provider”

UNLIMITED INTERNET ACCESS
Starting at $15/month!
DSL & Wireless Access, Web Design
& Hosting Services
www.snowcrest.net
(530) 245-4698 / (530) 926-6888

Shasta Lake, CA 96019

Breakfast & Lunch Daily
Opened Every Friday Until 9 PM
Different specials every week!

Stop throwing away your inkjet cartridges!
Let us refill them and save up to 60%
We also offer services for toner cartridges
2521 Hilltop Drive (Across from Big 5) Redding, CA 96002
Phone 530-222-INKS (4657)

1730 Pleasant St., Redding, CA

(530) 241- 8646

IBMPC Users Group Of Redding
Membership Application
Name(s): _____________________________________________________
$25.00
Address: _____________________________________________________
DUES PER
City:________________________________ State: _________ Zip: _______YEAR
Home Phone: __________________ Business Phone: ______________ ___ New
E-mail Address: ________________________________________ _____ __ Renewal
Cash
Date: __________
Check
MAIL TO: IBM/PC Users Group of Redding,
P.O. Box 494778, Redding, CA 96049
(For general information call any Officer or Director listed on Page 2)
Not A Renewal Reminder
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Multi-Media SIG
Learn about Digital Device
usage of free software for Movie
Creation, Photo Projects, Music Projects,
and Social Networking. Includes Windows
7 Basic Instruction. Thursday 1-3pm at
the Anderson Senior Center. You can also
connect to the classroom via high speed
internet to the SKYPE ID AAASCO2009.
Walk-in 3pm to 4pm for tutoring or special
projects.

IBM/PC Users Group
of Redding
P.O. Box 494778
Redding, CA
96049-4778

(Only members will be able to use the
club’s laptop to burn their DVD movies.)

Saturday — 10 AM, May 21
At Jane Quinn’s Home, contact
following for information:

Jane Quinn, 365-0825
qjquinn7427@gmail.com

DTP and

Graphics Art SIG

4th Tuesday Monthly Meetings Are At

The R
edding Library
Redding

Do you have an interest in creating DeskTop
Publishing projects, such as flyers, business
cards, logos, newsletters, etc., or art and
photo editing and manipulation? We have an
informal forum, so bring a question, problem,
project and we’ll all work together to solve it.
Basic Windows knowledge of copy and
paste is a must.

Has closed for now.
See map below for meeting
place.

Judi Ball 275-4632
jebed@charter.net

Windows
&
More
SIG

1100 Parkview Ave.,
off Cypress and to the right of City Hall.
We will be in the Community R
oom, which is to the left
Room,
of the main library door.
Why Join A
Computer Group?
1. Benefit from a common interest in a personal
(and costly) investment: Your business or
personal computer.
2. Enjoy more of that investment by learning
more about it.
3. Share tips and tricks, as well as new and
old ideas.
4. Become exposed to a variety of new
hardware and software without sales
pressure.
5. Receive an informative monthly newsletter.
6. Have access to various club func-tions and
all Special Interest Groups (SIGs).
7. Find out that no one needs to be alone and
helpless with today’s computer technology.

Has closed for now.

Bill Ball 275-4632
bcard9@charter.net
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